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Editorial
At the combined New Zealand and Australian Entomo-
logical societies conference in August 2011, I was inter-
ested to hear the developments in some of the online tax-
onomic databases now being developed. Specifically, the
initiatives of interest include the Australian Faunal Direc-
tory, PaDIL, and IdentifyLife. These projects are exciting
and it will be great to see what they turn into. However,
they need taxonomic input, which begs the question: what
reward systems are in place to encourage taxonomists to
take part? Money is certainly one aspect of this, but recog-
nition by peers and funding bodies is also very important;
and in my view has not yet been adequately addressed.
Until it is clear how activity on online databases can ap-
pear on funding applications, CVs and obituaries, I sus-
pect online databases will have trouble recruiting third
party taxonomic expertise.

Samuel Brown

Outgoing President’s Report

The past two years have been fairly quiet ones for SASB.

They began with a rebuilding of the SASB website. The site now includes separate
pages for:

• Job and scholarship notices,

• Tertiary-level systematics courses and training workshops,

• Journals which publish taxonomic and systematic papers, and

• Upcoming conferences of interest to the SASB membership.

The website thus acts as a bulletin board for SASB members and others, and supple-
ments the announcements emailed directly to members by the Secretary. Contributions
welcome!

The SASB domain, ‘sasb.org’, is still registered with MelbourneIT, but our name-
servers and webpages were moved in 2009 from bur.st in WA to DeCompression in
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Queensland. Free hosting with DeCompression was arranged for us by Tristan Clar-
idge, whom many SASB members will have met as the IT and audio-visual officer at
conferences organised by Sally Brown over the past 10+ years.

The SASB newsletter Banksia continues to be very ably edited by Samuel Brown,
with five issues produced since the last general meeting (November 2009, July and
December 2010, June 2011 and January 2012). Banksia is sent directly to members as
a PDF and is also available for download from the SASB website.

One of the many interesting items in Banksia was the outcome of a self-reporting sur-
vey of SASB member activities in 2010. I was impressed that nearly 80% of respon-
dents had identified specimens on request during the year, and 50% had published a
Code-compliant taxonomic work.

At the request of a number of systematists, SASB strongly objected in 2010 to the low
journal rankings for systematics journals given by the Australian Research Council
in its Excellence in Research for Australia (ERA) initiative. A full record of SASB
correspondence with the ARC is on the SASB website. The ARC announced in 2011
that it was abandoning the journal ranking system.

The journal ranking debate was the only one over the last two years in which SASB
took a position publicly. Through Vice-President Penny Mills, we also participated in
a Taxonomy Australia (TaxA) meeting in May 2010.

I will be stepping down as President at the general meeting in December 2011, and
would like to thank our Secretary, Andrew Thornhill, for his support over the past two
years.

Bob Mesibov

Student Prizes at the 10th IBCC/SASB combined conference

At the combined 10th Invertebrate Biodiversity and Conservation/Society of Australian
Systematic Biologists Conference recently held in Melbourne, four prizes were awarded
to the best student presentations. The prizes were donated by the CSIRO Publish-
ing journal Invertebrate Systematics and consisted of two book prizes (Australia, New
Zealand, Antarctica and New Guinea Photographer of the Year) and two $100 vouch-
ers for use for titles at CSIRO Publishing.

The judging committee for the prizes was comprised of two members of the conference
organising committee (Robin Wilson and Tim New), as well as outgoing SASB Pres-
ident, Bob Mesibov. Oral and poster presentations were treated identically (i.e. there
were no separate oral or poster categories, it is coincidental that in the end all prizes
were awarded to oral presentations). We judged the best presentations as follows:

1st Kathryn Sparks (The University of Adelaide)—Morphology, molecules and Mono-
morium: surprising or suspect species diversity in a large and taxonomically diffi-
cult genus of ants [$100 voucher].

2nd Sophie Harrison (The University of Adelaide)—Exploring new species diversity
among troglobitic pseudoscorpions of the Yilgarn and Pilbara Regions, Western
Australia [$100 voucher].
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3rd Penelope Mills (The University of Queensland)—Chromosomal evolution in a kary-
otypically diverse group of scale insects [book prize].

4th Andrew Heaver (The University of Melbourne)—Insects and incendiaries: The
ecology of invertebrates inhabiting flammable bark [book prize].

There were many excellent student presentations at the conference so it was a particular
credit to the four winners that there was a high degree of agreement among the judges
as to the placings. At the conclusion of the conference Robin Wilson announced the
prizes and congratulated the winners and Prof. Andy Austin, as Editor in Chief of
Invertebrate Systematics, made the presentations.

Robin Wilson

Hypothetically Speaking

Lyn Cook (University of Queensland) gave a wonderfully original talk at the recent
SASB/IBCC conference in Melbourne. She made several challenging points, one of
which I might paraphrase this way:

Taxonomy suffers from a shortage of testable hypotheses. Suppose a taxonomist pub-
lishes a paper and says that there’s such a thing as species A and it’s different from
species B. How can anyone test this claim to see if it’s true?

Lyn argued that no test is possible unless the taxonomist explicitly designates A and
B according to a particular species concept. Since many taxonomists delimit species
without being explicit in this way, taxonomy risks being seen as ‘science Lite’. If
no explicit hypothesis is offered, then no refutation is possible within a hypothetico-
deductive framework.

For a very long time (think of Aristotle’s History of Animals), descriptive taxonomy
was descriptive and not much more. Species A was different from species B because
the two were described as different. No explicit species concept was necessary. If there
was an hypothesis lurking somewhere in the descriptions and differential diagnoses, it
was that any specimen collected in the A and B ranges would be assignable to A or
B. If a specimen clearly wasn’t A or B, we might have species C, for which another
description and revised diagnoses would be necessary. There is no hypothesis that A
was different from B, so the finding of C cannot invalidate this non-existent hypothesis.

(If you’ve been thinking this applies only to morphological taxonomy, read that last
paragraph again with barcodes or 28S in mind. Same story.)

During the first half of the 19th century, taxonomists came to accept the idea that the
classification system in which species were organised needed to reflect evolutionary
history. The taxonomic hierarchy should, ideally, map the historical hierarchy. That
way of thinking has underlain systematics for ca. 150 years now, and it imposes very
strong constraints on classification. Whether it also imposes constraints on species
delimitation has been the subject of many papers and a great deal of argument.

Some systematists, for example, like the idea of ‘species thresholds’. If genetic dif-
ferences between similar-looking individuals segregate neatly into 1–5% and 15–20%
classes, many systematists will quite reasonably assume that 1–5% is intraspecies vari-
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ation and 15–20% is interspecies variation. In this case, 15% becomes a threshold
figure for delimiting species. Is there an explicit species concept here? No, because
lineage divergence is a fact of life, not a species concept. Species thresholds are oper-
ational definitions for species, and almost theory-free. It’s true that most such thresh-
olds have been empirically calibrated using species delimited by other means, and you
might argue that they inherit a species concept that way. My response is that the same
threshold could work equally well for a wide range of species concepts.

Back to the descriptive species-delimiting protocol I mentioned above. Some authors
regard this as based on a Diagnosable Species Concept, which to my mind is like saying
that a green car is different from a red car according to a Motoring Fashion Concept.
Diagnosis is an operation, and we use it to delimit species operationally.

It’s possible to load a diagnosis with evolutionary theory, of course, but you don’t have
to. You can delimit species without having a clue how they’re related, then follow
up the diagnoses and descriptions with analyses that infer a pattern of evolutionary
relationships, leading (we hope) to a more natural classification.

But ‘pattern of relationships’ between what? Not ‘species’, because that isn’t how
phylogenetic inference works. Inference starts with a set of characters and a model of
evolution, and then generates a plausible hierarchical pattern showing how the charac-
ters might be historically related. A different tree might appear after a different analysis
of the same set of characters, or after the same analysis of an expanded set of characters
from the same exemplars or ‘species’. But the tips of the tree don’t change—only the
nodes. To change the ‘species’ grouping of the tips requires applying a species concept
after the analysis. Phylogenetic inference itself is not an operational way to delimit
species.

If you like Lyn Cook’s approach to species-as-hypotheses, you have a wide range of
explicit species concepts to choose from. For a concise overview I highly recommend
John Wilkins’ excellent 2006 blog posting: A list of 26 species concepts.

Finally, for a particularly good example of how to be explicit when delimiting species,
see:

Palmer, C.M., Trueman, J.H. & Yeates, D.K. 2007. Systematics of the Apteropanorp-
idae (Insecta : Mecoptera) based on morphological and molecular evidence. Inverte-
brate Systematics 21(6): 589-612.

Here the authors report what seems to be a routine systematic exercise. It’s a cladistic
analysis of a 36-character morphology dataset, COI sequence data, and a combined
morphological/molecular dataset, from 21 sampled populations of a genus with two
described species. What the authors do next is review their results in the light of at
least six different species concepts. For example, cladistic analysis identifies a lowland
clade of a mainly mountain-dwelling taxon. These lowland populations have a distinct
genitalic morphology, which:

“agrees with the potentially interbreeding biological species criterion of de Queiroz
(1988). . . As members of this clade also form a distinct cluster of haplotypes, and form
a diagnosable monophyletic group, this clade also conforms to the genotypic clus-
ter species definition of Mallet (1995), and the autapomorphic (Donoghue 1985) and
diagnosable phylogenetic (Eldredge and Cracraft 1980; Cracraft 1983; Nixon and
Wheeler 1990) species concepts. These populations also inhabit a different altitudi-
nal range from all other members of the family, and are therefore congruent with the
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ecological species concept of Van Valen (1976), and the adaptive zone criterion of de
Queiroz (1998). These populations are therefore regarded as a distinct, undescribed
species. . . ”

which the authors go on to describe in the formal taxonomic section of their paper.
They also describe a second new species because

“Adults of the population from Hartz Peak possess a unique combination of morpho-
logical characters. . . Males from Hartz Peak also possess distinct, readily diagnosable,
genitalic autapomorphies. . . These features of the genitalia indicate that this popula-
tion is reproductively isolated from all others. The haplotype of the Hartz Peak popu-
lation is also different from that of all other members of the family, and constitutes its
own, well-supported clade. The Hartz Peak population therefore meets the biological
species concept, autapomorphic and diagnosable phylogenetic species concepts, and
genotypic species definition, and is regarded as a separate, undescribed species.”

Bob Mesibov

Caption competition

The following picture is a scene from the recent 10th IBCC/SASB conference held
in Melbourne in December. Speculate as to what is happening in the image. What
profound insights are being discussed between the figures in the centre? Alternatively,
what are the characters on the left and right thinking?

Image courtesy of the Medieval Woodcuts Clipart Collection.

Please send your answers to the newsletter editor: sam.brown@lincoln.ac.nz. A selec-
tion of the most humorous, geeky and accurate answers will be published in the next
issue.

Samuel Brown

2nd National Systematics Postgraduate Workshop: a student’s per-
spective

What else could have brought 32 students from every corner of Australia, whose com-
bined taxa of interest covers the entire tree of life, to Adelaide?
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Over five days we had the luxury of stepping back from our respective labs and com-
puters to enjoy the feeling of being taught cutting edge science by experts, whether
systematics was our major focus or an add-on to our respective projects.

Dr Mike Lee opened the festivities by refreshing the basics of phylogenetics and, after
a quick reminder of maximum likelihood vs bayesian modeling, unleashed the BEAST
(tamed by BEAUti); Dr Michelle Guzik introduced the user-friendly and visually at-
tractive Geneious genetic data analysis software; Dr Hugh Cross gave a thorough up-
date on the situation of barcoding and associated internet-based resources; Dr Steve
Donnellan unravelled the prospects behind next-generation sequencing; Dr Ian Whit-
tington pointed out how museum collections can and should be used for best data stor-
age and accessibility; Drs Mark Harvey and Judy West accomplished the big task of
clarifying the taxonomic process; Dr Donald Hobern introduced the concept of cyber-
systematics via the Atlas of living Australia, and, last but not least, coordinator Prof.
Andy Austin provided precious tips for successful publishing (or how to woo an edi-
tor!) and a useful update on available research funding resources.

Another highlight of the week was a thrilling 5 min/5 slide marathon organised on
two successive evenings in order to give each participant a chance to present their
research. Congratulation to S. N. Phoon (James Cook University), C. Puente-Lelievre
(James Cook University), V. D. Racero (Adelaide University) and A. Wiewel (Adelaide
University), who received a bottle of wine (each) for the best presentations!

Fieldtrips to the herbarium and the science centre on the rainiest day of the week sat-
isfied even the most adventurous of us; however most of the actual sampling was done
on food, and included Asian, Australian and Italian lineages.

In the evenings the workshop continued, often around a bottle of wine, for one of
the most valuable assets of this course was to bring together early career scientists with
many different backgrounds and origins, all sharing the same enthusiasm for their work
and eager to learn from one another.

What a great week!

Maı̈a Berman
PhD candidate

Charles Darwin University/CSIRO/University of Montpellier
Maia.berman@csiro.au

Nomenclature symposium online

On 28 October 2011, the International Symposium for Zoological Nomenclature (ICZN)
hosted a symposium “Anchoring Biodiversity Information: From Sherborn to the 21st
century and beyond” honouring 150 years since the birth of Charles Davis Sherborn,
who compiled the Index Animalium, a key text in zoological nomenclature and the
history of taxonomy. The symposium featured talks discussing Sherborn’s life, work
and influence, the history of taxonomic indexing, the digitisation of heritage literature,
and perspectives on how technological advances will influence the way taxonomy is
practised and published.
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Left: Subset of participants after the “mid-course barbie” organised at the University (from
left to right, by taxon of interest: horse flies, ants, bees, crayfish, sharks, isopods,

pseudoscorpions, polychaetes, wasps, coccids). Right: Subset of participants sampling
Italian food at Amalfi’s (from left to right: crayfish, ants, isopods, sponges, polychaetes,

birds, plants (Loganieae), plants (lilies)). Photos: Maı̈a Berman.

Some of the workshop facilitators after the closing lunch at the Adelaide University Club
(from left to right: Prof. Andy Austin, Dr. Michelle Guzik, Dr. Ian Whittington, Dr. Mike Lee).

Photos: A. Bentley
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For those of us who couldn’t duck over to London for the symposium, we are in
luck. The ICZN has made all the talks available for our listening and viewing plea-
sure (http://iczn.org/sherborn). Currently, however, only two of the presentations are
available as full videos; but all talks have slides and audio available for downloading.

The talks are interesting and enjoyable, and seemed to have been fairly informal, with
many of the presenters sounding laid back, interacting and joking with the audience.
The speakers included well-known figures who are deeply involved in such aspects as
the digitisation of heritage literature and databasing initiatives. Hearing the subtleties
and the challenges involved in their work and their view on the importance of it makes
one appreciate the effort that is involved, and why it may not be moving as quickly as
some of us think it should be. The cataloging of life is a big project, involving a large
number of people and organisations, and operating in a very rapidly changing techno-
logical environment. The people involved are ambitious, but also forward-thinking; in-
tending to create a system that will serve the taxonomic community for several decades,
as the Index Animalium has.

Samuel Brown

State Herbarium of South Australia publications now online

The new “Publications” web-page of the State Herbarium of South Australia has been
online since 26 October 2011 (http://www.flora.sa.gov.au/publications). Users can
view information on all books published by the State Herbarium and its staff, the Board
of the Botanic Gardens & State Herbarium (Adelaide), and botanical books published
by the ‘Flora and Fauna of South Australia Handbooks Committee’. If in-print these
can be ordered via email. Some out-of-print books are available for download, e.g.
Womersley’s Marine benthic flora of southern Australia or Bates & Weber’s Orchids
of South Australia. More scanned books will be added over time.

The complete back-issues of the Journal of the Adelaide Botanic Gardens covering vol-
umes 1 (1976) to 24 (2010) are also freely available. (http://www.flora.sa.gov.au/jabg).
The journal mainly publishes research papers and articles on botanical taxonomy, sys-
tematics and nomenclature. It is one of five taxonomic journals published by Australian
herbaria and botanic gardens. The next volume of the journal is scheduled for 2012.

Finally, the first chapters of the new, 5th edition of Flora of South Australia were
launched in October as well (http://www.flora.sa.gov.au/ed5). These include an in-
troduction, glossary and revised treatments for 17 families or larger groups, such as
Amaranthaceae (amaranths), Droseraceae (sundews), Ranunculaceae (buttercups), and
part of Fabaceae (legumes). For people who want to bind these chapters into a folder,
cover pages are also provided for print-out. More than 60 botanists are contributing to
the new flora. We anticipate to release more treatments every 4 to 6 months.

Jürgen Kellermann
State Herbarium of South Australia

DENR Science Resource Centre
Adelaide, Australia

juergen.kellermann@sa.gov.au
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Adding setae to Inkscape drawings

In the last issue of Banksia, I wrote a tutorial giving an introduction to creating line
drawings using the free vector-graphics program Inkscape (http://www.inkscape.org).
The following builds on that tutorial presenting a method to easily create and manipu-
late representations of setae, as part of giving extra detail to the drawing.

1. Load previously made vector graphic image.

2. Show gridlines over the image by going View > Grid (#).

3. Using the pencil tool (P), create an elongate isoceles triangle with the base
to the right and the tip to the left. Make it perfectly straight, as any curves will
be distorted later. Make it off to the side of the image (Figure 1).

4. Make the seta a bit more realistic by curving the base of the triangle and creating
a circle around the base (Figure 2). Select the whole seta and combine both
objects into a single object by using Path > Combine (Ctrl + K). Once the
objects have been combined, copy the resulting object. (Edit > Copy (Ctrl +
C)).

5. Adjust the size of the seta by moving the handles that appear when the pointer

tool is selected (F1). The seta needs to be an appropriate size relative to the
structure it will be placed.

6. With the pencil tool, create a straight line by clicking once where the base of the
seta should start, and once where the seta should end (Figure 3).

7. Open the ‘Path Effect Editor’ by going Path > Path Effect Editor (Ctrl +
Shift + 7). In the ‘Apply new effect’ drop-down menu, select “Pattern Along

Path” and click ‘Add’. In the options that arise, click the icon to place the
pattern of the seta (copied in step 4) onto the path that was created in step 6
(Figure 4).

8. Using the nodes tool (F2) the length and curve of the seta can be adjusted.

9. Continue steps 6 to 8 until all the setae required have been added.

10. The weight and fill of the setae can be changed via the ‘Fill and Stroke’ dialog
box Object > Fill and Stroke (Ctrl + Shift + F) (Figure 5). Changing the
fill of setae to white gives the image perceptual depth.

The SVG file used as the example in this tutorial and shown in Figure 5 (right) can be
downloaded from GitHub. Please note that Windows has poor support for SVG files.
To avoid frustration, it’s a good idea to install Inkscape prior to trying to view SVG
files.

Samuel Brown
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Figure 1. Vector graphic drawing of a beetle antenna. To the right is the isoceles triangle
that will form the template for the setae.

Figure 2. Seta with base added.
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Figure 3. Line that forms the path for the seta.

Figure 4. Seta template added onto path.
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Figure 5. Modyifying the line weight, fill colour and adding a curve to the seta.

Figure 5. Drawing of antenna, showing the starting image (left) and the same image with
added setae (right).
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About the Society

SASB Officers:
Steve Cooper (President)
Steve.Cooper@samuseum.sa.gov.au
Penny Mills (Vice-President)
Andrew Thornhill (Secretary)
andrew.thornhill@anu.edu.au
Andy Austin
Catherine Byrne
Lyn Cook
Laxmikant Dama
Bob Mesibov
Andrew Mitchell
Kevin Thiele

Samuel Brown (Newsletter Editor,
non-executive position)
sam.brown@lincoln.ac.nz

The Society:

The Society of Australian Systematic Biologists is
open to all people who utilise the science of bio-
logical systematics as a basis for the study and un-
derstanding of nature. The Society is a non-profit
inter-disciplinary organisation whose purposes are
to promote the scientific study of biological system-
atics and to disseminate scientific and educational
information related to its fields of interests.

Membership:

Membership is free. Details are available on the society
website (http://www.sasb.org.au/contacts.html) and from
the secretary.
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